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Overview of Data File Mapper Plus
Data File Mapper Plus is the newest Registry Plus program and is currently ready for beta testing.  Data File Mapper Plus is a user-friendly, standalone, Windows-based file mapping tool that maps data items from any fixed width or delimited file to the North American Association of Central Cancer Registries (NAACCR) file format. This application will provide support to central cancer registries with:

· Death clearance linkage efforts: mapping of vital statistics data for linkage with central registry data
· Follow-back file generation for follow-back efforts in Web Plus: mapping of vital statistics information for cancer-related deaths in order to generate pre-filled abstracts to be loaded into Web Plus for physician follow-back efforts
· Mapping of National Breast and Cervical Cancer Early Detection Program Data:  mapping of NBCCEDP data for linkage with central registry data (now required twice annually)
· Mapping of files received in formats other than NAACCR-formatted files: map files received in non-NAACCR formats, so that they can be further processed by the CCR
· Mapping of data for Registry Plus conversion: Map data from current central cancer registry database extracts to the NAACCR file format required for Special Import into CRS Plus

· Data Standardization: Mapping of data in foreign countries to the NAACCR file format, enabling use of Registry Plus products
The file mapping process is accomplished in three basic steps: 1) Selection of the NAACCR version for the NAACCR output file and documentation of any non-standard fields; 2) Generation of a file mapping configuration specific to the input data file; and 3) conversion of the input file to the designated NAACCR file format using the specified mapping configuration.

Mapping configurations include the specification of the input data type (fixed width or delimited), as well as the input file record layout for fixed width files, or file delimiter, field names, and field sequence for delimited files.  For each field in the input file to be mapped, the user specifies the NAACCR data item to which the field will be mapped. Field codes within the input file are converted to NAACCR data field codes via user entry of translation tables or through selection of the various conversion functions that are available within the program. In addition, a powerful filter feature is included in the program which enables the mapping and output of select records from the input file.  File conversion includes locating and identifying the input file to be converted, and then selection of a mapping configuration to apply to the file upon conversion.
Managing the NAACCR Version

Prior to the mapping any data file to the NAACCR file layout, a NAACCR record version must be selected for the output file, and any non-standard fields (i.e., any field not included in the NAACCR standard fields listed in the NAACCR Volume II Data Dictionary: http://www.naaccr.org/standards/volumeii) must be entered into the layout.

To launch the Data File Mapper Plus program and manage the NAACCR record version of the NAACCR output file, follow these steps:

1. Point to Start (All Programs ( Registry Plus ( Data File Mapper Plus ( Data File Mapper Plus.
Result: The Data File Mapper Plus Main window opens.  
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2. Click on the Tools menu item, and then click Manage NAACCR Layout.
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Result:  The Manage NAACCR Layout window opens.
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The Manage NAACCR Layout window contains these fields and columns:

	Column Heading
	Description

	Select NAACCR Version for Output File
	Version of NAACCR file format to which you would like to map the input data file

	NAACCR Item No
	NAACCR data item number of the non-standard data item (must be in the 9500-9998 range)

	Name
	User-entered name for the non-standard data item, use alpha-numeric characters and spaces only.

	Mapping Configuration
	Name of mapping configuration

	Column Start
	Start column position of the non-standard field in input file (must be in the 2340-3339 range)

	Column End
	End column position of the non-standard field in input file

	Field Length
	Field length of non-standard data item (automatically filled when you complete entry of Column Start and Column End positions)


3. Select a NAACCR version for the NAACCR output file from the Select NAACCR Version for Output File drop-down list (you can select v12x for any NAACCR version 12.x). By default, version 12x_CAST is selected, as this version of the software was generated for the standardized B&C linkages.
4. For any non-standard data items, enter the item number, name, column start position, and column end position into the grid provided; field length is auto-filled after you have entered column start and column end positions. In the example shown, the project-specific data items for the standardized B&C linkages are being entered.
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5. Click Ok.
Result:  You are returned to the Main window.  The NAACCR version has been set for the mapped output file, and any information entered on non-standard fields is saved.

[image: image5.png]Fie Tools





Mapping Configuration

Prior to mapping any data file to the NAACCR file layout, a mapping configuration for the input data file must be created and saved.  Creating a mapping configuration entails naming the mapping configuration, and specifying what data type, fixed width or delimited, is included in the input data file. 
Data File Mapper Plus also includes an optional filter feature which enables the user to selectively map records from the input file and output only a subset of records from the input file in the NAACCR file format.  For example, when conducting death clearance efforts a central cancer registry might perform 2 file mappings from their annual vital statistics data file.  The first mapping would include the mapping of all records in the input file to the NAACCR file format and codes, enabling linkage with the central registry database to identify patients in the database that have died, providing essential follow-up information for the registry.  The second mapping would include use of the Data File Mapper Plus filter feature on same vital statistics input file to include only those records in the file with a cancer-related Cause of Death code in the output file. The mapping of only cancer-related death records to the NAACCR file format and codes would enable linkage with the central registry database to identify Death Certificate Only cases in need of follow-up.
For fixed width input files, a record layout is entered which includes each field name and location in the input file.  File delimiter, field names, and field sequence are entered for delimited files. While entering the input file record layout, each field being mapped is associated with a respective NAACCR data field via the NAACCR data item number.  Codes for each field are converted to NAACCR data field codes via user entry of translation tables or through selection of the various conversion functions that are available within the program.
To create a mapping configuration to map a fixed width or delimited data file to the NAACCR file format, fields and codes, follow these steps:

1. Click on the Tools menu item, and then click Manage File Mappings.
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Result:  The Mapping Configurations window opens.
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Existing mapping configurations can be opened and edited by selecting the existing mapping configuration from the list provided, and clicking Edit. A new mapping configuration can be created by clicking New.
To introduce the process of generating a mapping configuration, we will open an existing mapping configuration.  In the example shown, the existing example mapping configuration called Test Death is opened. 

2. Select the Test Death mapping configuration, and click Edit.
Result:  Because the TestDeath mapping configuration is an example mapping configuration for an input data file in fixed width format, the Create Fixed Column Map window opens.
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The Create Fixed Column Map window contains these fields and columns:
	Column Heading
	Description

	Mapping Configuration
	Name of mapping configuration

	Input Data Type
	Data type (fixed width or delimited) of input data file

	Filter
	The filter feature enables mapping and output of select records from the input file based on user-specified values for a specific field or fields; Click here for more information on filters 

The label under the filter textbox shows an example filter with which only records with a value of “ZZ” in the State field and “M” in the Sex field will be mapped over to the output file

	Input Field Name
	User-entered name of field in input file; use only alpha-numeric characters and spaces for field names.

	Input Column Start
	Start column position of field in input file

	Input Column Stop
	End column position of field in input file

	Output NAACCR Item
	NAACCR data item number of NAACCR field to which input field is being mapped

	Output Default Value
	For NAACCR fields not represented in the input file, a default value may be entered; this value will be automatically filled into the specified field for every mapped record in the output file

	Output Over-ride Value
	For fields that contain a value for a NAACCR data item in the input file, an output over-ride value may be entered; this value will  automatically overwrite any existing or mapped value for the field in the output file

	Translation Table/Function
	Translation table or function that has been selected for input fields with values that that require conversion to NAACCR values for the output file; Please see Translation Tables and Mapping Functions for more information

	Function Parameter1
	Enter additional function parameters if necessary

Some functions (e.g., REPLACE) require entry of additional parameters by the user

Specify the first parameter in Function Parameter1 column, and the second parameter in the Function Parameter2 column; Please see Mapping Functions for more information

	Function Parameter2
	


3. Click Cancel to close the Select the Test Death Fixed Column Map window and return to the Mapping Configurations window. Next we will view an example of a mapping configuration for an input file in delimited file format. In the example shown, the existing example mapping configuration called Sample pipe-delimited map for DC is opened.
4. Select the Sample pipe-delimited map for DC mapping configuration, and click Edit.
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Result:  Because the Sample pipe-delimited map for DC mapping configuration is an example mapping configuration for an input data file in delimited file format, the Create Delimited Map window opens.
[image: image10.png]=lo/x|
Mapping Configuration [Sample pips-delmted map for DC _ Pt | _FndNAACCREem... |
Input Deta Type: [ Delmter [T
Fiterappled othe nput ) [SEX="T" Validste
ISTATE] - "2Z" AND [SEX] - "M
‘Enter name and sequence of input fields. and speciy mapping information
A hse (Mo, (v O | o Talrsin = ==
1 [-]
o 5 B e
T ) =l
Lrame 2 20 FUNCTIONREPLACE i
Frame B 20 =l
Hiname n 250 =l
DatelastContact_ |5 ) =l
Hsp B 90 =l
Face 7 ) =l
Sex B 2 e
Béay B 20 FUNCTION NAACCRDate =l
B 0 220 =l
Sder T 250 =l
oy B 10 =l
B B 520 =l
) 0 ) =l
Aton " ) =l
Vicart B 2 =l L
= ® ) =l
= ® B =l
= ® a0 =l -





The Create Delimited Column Map window contains these columns:

	Column Heading
	Description

	Mapping Configuration
	Name of mapping configuration

	Input Data Type
	Data type (fixed width or delimited) of input data file

	Filter
	The filter feature enables mapping and output of select records from the input file based on user-specified values for a specific field or fields; Click here for more information on filters 

The label under the filter textbox shows an example filter with which only records with a value of “ZZ” in the State field and “M” in the Sex field will be mapped over to the output file

	Input Field Name
	User-entered name of field in input file; use only alpha-numeric characters and spaces for field names.

	Field Seq
	Sequence of the specified input field in the input file; Note:  if defaulting values for fields not included in the input data file, the Field Seq is set to 0 (zero)

	Output NAACCR Item
	NAACCR data item number of NAACCR field to which input field is being mapped

	Output Default Value
	For NAACCR fields not represented in the input file a default value may be entered; this value will be automatically filled into the specified field for every mapped record in the output file

	Output Over-ride Value
	For fields that contain a value for a NAACCR data item in the input file, an output over-ride value may be entered; this value will  automatically overwrite any existing or mapped value for the field in the output file

	Translation Table/Function
	Translation table or function that has been selected for input fields with values that that require conversion to NAACCR values for the output file; Please see Translation Tables and Mapping Functions for more information

	Function Parameter1


	Enter additional function parameters if necessary

Some functions (e.g., REPLACE) require entry of additional parameters by the user

Specify the first parameter in Function Parameter1 column, and the second parameter in the Function Parameter2 column; Please see Mapping Functions for more information

	Function Parameter2


	


5. Click Cancel to close Sample pipe-delimited map Create Delimited Map window and return to the Mapping Configurations window. 

6. To create a new mapping configuration, click New…
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Result:  The Create New Mapping Configuration window opens.

[image: image12.png](] Mapping Configuration
Mapping Configuration: [BCCEDP Mapping Configuration

Input Data Type: @ Fixedwidth ¢ Delimited

Delimiter: |
ok Cancel





7. Enter a name for the new mapping configuration, select the data type of the input file data to be mapped, and click Ok.  In the example shown, a new mapping configuration called BCCEDP Mapping Configuration is created for a fixed width data file.

Result:  The Create New Mapping Configuration window closes and you are returned to the Mapping Configuration window, where the new mapping configuration is now listed and available for editing.
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8. Select the newly-created mapping configuration (BCCEDP Mapping Configuration) and Click Edit.
Result: Either the Create Fixed Column or Create Delimited Map window opens, depending on the input data type that was specified for the mapping configuration.  In the example shown, a mapping configuration for a fixed width file is being mapped.
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9. Enter a data field filter if applicable.  In the example shown, the input data file is being filtered on an input data field called Diagnosis_type; only records containing a value of “B” in the Diagnosis_type field will be mapped to the output file.  
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	The field that you are filtering upon must be entered for the layout, even if the field itself is not mapped over to the output file (i.e., record layout information must be entered for fields whose sole purpose is for filtering records to include in the output file).  


An Aside on Filters and the Mapper.mdb
When entering the filter information on the mapping configuration form there are a couple of coding conventions for the filter field. You must use specialized terms and syntax for the filter that are specific to the Data File Mapper Plus application.
	Coding Convention
	Example

	[ ] are placed around the data item name, and “” are placed around the specified values to filter upon. 
Use relational (=, <, >, and <>) and logical operators (AND, OR) to compare field values to literal values.  
	1. [Diagnosis_type] = “B” 
Specifies that only records containing a value of “B” in the input field of Diagnosis_type will be included in the output file.

2. [STATE] = “ZZ” AND [SEX]=”M”

Specifies that only records containing a value of ZZ in the input field of state and a value of M in the input field of sex will be included in the output file.

3. [AGE]>”75”

Specifies that only records that have values higher than 75 in the age field will be included in the output file.

	SEARCH{[ ],Tablename}

If filtering based on a large number of input values, the Data File Mapper Plus Mapper.mdb may be utilized to store a table of values upon which to search. 
The table used for this purpose must have two columns in it – ID and Term, where ID is a unique identifier column and Term is the column that contains the values the SEARCH function looks for. A table called SSNTABLE is included in Mapper.mdb as an example. 
Located in the C:\RegPlus\DFMapper folder, the Mapper.mdb Access database contains all of the tables that are used by Data File Mapper Plus.
	SEARCH{[SSN],SSNTABLE}

Specifies that only records containing values for the input SSN field that are included in the SSNTABLE in the Mapper.mdb will be included in the output file.
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10. Begin entering input data field names, and column start and stop positions (or names and field sequence for delimited files). 

The NAACCR data item to which the field is being mapped can be manually entered into the Output NAACCR Item column if known, or can be looked-up and selected from a searchable list of all NAACCR data items.
11. To look-up the NAACCR data item number for a particular field, click Find NAACCR Item.

Result: The NAACCRItems window opens. 
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12. Scroll through the NAACCR data items until the desired NAACCR data item is located, and double-click on it to transfer the data item number to the Output NAACCR Item column in the mapping grid. 
Result:  The desired NAACCR data item number is transferred to the Output NAACCR Item column in the mapping grid. 

[image: image18.png]=lolx|

Mapping Configuration: [BCCEDP Mapping Corfiguration =) Find NAACCR
put Data Type: & Fxeduid € Defmied Deimeer [
Fiter (applied to the input file)  [IDiagnosis_type] = "B Valdate.
[STATE] = "ZZ" AND [SEX]
‘Enter name and position of input fields, and specify mapping information
fpared puolm guokm oed 0, (0| e =

Diagrosis fype _|316 316

Last Name. 16 55 230





13. Continue to enter input field names and information.  
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	If a filter is specified for the mapping configuration, the field that you are filtering upon must be entered for the layout, even if the field itself is not mapped over to the output file (i.e., record layout information must be entered for fields whose sole purpose is for filtering records to include in the output file).  In the example shown above, the field of Diagnosis_type is used for filtering purposes only; record layout information has been entered for this field, but it will not be mapped over to the output file, as it has not been associated with a NAACCR data item to which to map.


Codes and values for each field are either mapped exactly over to the desired position in the output file, or can be converted to NAACCR data field codes via user-defined translation tables or through selection of the various conversion system-defined and user-defined translation functions that are available within the program.  If translation between input field values and NAACCR values is required, the appropriate translation table or function is selected from the Translation Table/Function column drop-down list.
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14. When you have completed entering input field names and information, click Ok to save your changes.  

Result:  The changes to the new mapping configuration are saved, and you are returned to the Mapping Configuration window.
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15. Click Cancel to close the Mapping Configuration window and return to the Data File Mapper Plus Main window.
Translation Tables
Although Data File Mapper Plus includes some example translation tables, most users will need to enter their own translation tables that are specific to the data file and fields being mapped. Users generate and maintain translation tables via a user-friendly interface.
To create a new translation table or manage an existing translation table, complete these steps:

1. Click on the Tools menu item, and then click Manage Translation Tables.
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Result:  The Translation Table window opens.
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2. To manage an existing translation table, select the table name from the Translation Table drop-down list.  To create a new translation table, click New.
Result:  The New Translation Table window opens.
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3. Enter a name for the new translation table, and click OK.  In the example shown, a translation table called BCCEDP_Race is being created, and will translate the BCCEDP races code to the appropriate NAACCR race codes.
Result: The newly-created translation table is created, and is now available for editing.
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4. Select the newly-created translation table from the Translation Table drop-down list.

Result: The Translation Table window opens for the newly-created translation table.
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5. Enter values to be mapped from the input file in the codes column, and the values that they are to be mapped to in the output file in the naaccrcode column.  
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In the example translation table shown the following values are being entered:

	code (BCCEDP Race Code)
	naaccrcode

	1 – White
	01

	2 – Black or African American
	02

	3 – Asian
	96

	4 - Native Hawaiian  or Other Pacific Islander
	97

	5 - American Indian or Alaskan Native
	03

	7 – Unknown
	99

	8 – Asian/Pacific Islander (MDE v4.1 only)
	98


6. When you have completed entering codes to be translated, click Ok to save your changes and return to the Data File Mapper Plus Main window.  The new translation table will now be available for selection from the Translation Table/Function column drop-down list in the Mapping configuration window.
Mapping Functions
If extensive translation of values is needed for a particular data item, or if the data item must be re-formatted to meet NAACCR standards, Data File Mapper Plus offers some built-in translation “functions” to deal with these conversion issues.  There are System-defined functions, and User-defined functions available.  
System-defined Functions

Data File Mapper Plus includes various system-defined functions to deal with the conversion of different date formats, mapping of International Classification of Diseases ICD-10 Cause of Death (COD) codes to NAACCR Primary Site, Behavior, Histology and Laterality codes, and various other mapping conversion needs.  

The following system-defined functions are currently available in Data File Mapper Plus.  If translation between input COD fields in ICD-10 format and NAACCR values is required, the appropriate function is selected from the Translation Table/Function column drop-down list on the Mapping Configuration window.

	Function
	Converts From
	To

	FUNCTION:ICD10ToSite
	ICD-10 Cause of Death codes
	NAACCR Primary Site codes

	FUNCTION:ICD10ToBehavior
	ICD-10 Cause of Death codes to 
	NAACCR Behavior codes

	FUNCTION:ICD10ToHistology
	ICD-10 Cause of Death codes to 
	NAACCR Histology codes

	FUNCTION:ICD10ToLaterality
	ICD-10 Cause of Death codes to 
	NAACCR Laterality  codes

	NAACCRDATE1
	MM/DD/YYYY, MM-DD-YYYY, MM.DD.YYYY date format  
	YYYYMMDD date format

	NAACCRDATE2
	DDMMYYYY, DD/MM/YYYY, DD-MM-YYYY, DD.MM.YYYY date format
	YYYYMMDD date format

	NAACCRDATE3
	YYYYMMDD, YYYY/MM/DD, YYYY-MM-DD, YYYY.MM.DD 
	YYYYMMDD date format

	FUNCTION: NBCCEDP_CaTypeFinalDxToSite
	National Breast and Cervical Cancer Early Detection Program (NBCCEDP) CaST Fields of Final Dx and Cancer Type
	NAACCR Primary Site codes

	FUNCTION: NBCCEDP_CaTypeFinalDxToHistology
	NBCCEDP CaST Fields of Final Dx and Cancer Type
	NAACCR Histology codes

	FUNCTION: NBCCEDP_CaTypeFinalDxToBehavior
	NBCCEDP CaST Fields of Final Dx and Cancer Type
	NAACCR Behavior codes


If you find you need additional system functions to accommodate your data translation needs, please contact Kathleen Thoburn (kthoburn@cdc.gov) to discuss the possibility of getting the function added to Data File Mapper Plus.  
User-defined Functions, or Functions Requiring User Input

User-defined functions are those translation functions that require user input.  Currently there is one user-defined function available in Data File Mapper Plus, called the REPLACE function. This function requires the user to enter two parameter values, Parameter1 and Parameter2.  The value entered for Parameter1 specifies the search value and the value entered for Parameter2 specifies the replace value. This function searches for the value in the first parameter and replaces that value with the value specified in the second parameter. 

To utilize the REPLACE function to re-format an input data field, follow these steps:

1. While entering mapping information for the field in either the Create Fixed Column or Create Delimited Map windows, select FUNCTION: REPLACE from the Translation Table/Function drop-down list.
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2. In the Function Parameter1 column, enter the value or term that you would like to search for and replace upon the mapping of the field. 

3. In the Function Parameter2 column, enter the value or term with which you would like to replace the value in Parameter1 column upon the mapping of the input data field to the output file. 
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In the example shown, the input data file includes dashes in the social security number field, and the REPLACE function is being used to search for the dashes and remove them (i.e., replace them with nothing). 

	[image: image30.png]



	If the desired action is to remove a value, such as dashes, the Function Parameter2 column should be left blank.

If the desired action is to replace a value with a blank, the Function Parameter2 column should be filled with a space. (i.e., click into the cell, and hit the spacebar a single time).




File Conversion

Once a mapping configuration has been generated for your input data file, Data File Mapper Plus is ready to convert your data file to the NAACCR file format and codes.  File conversion includes the specification of an input data file and a mapping configuration.
To use a mapping configuration to map a fixed width or delimited data file to the NAACCR file format, fields, and codes, follow these steps:
1. Click on the File menu item, and then click Convert.
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Result:  The Main Convert window opens.
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2. To select the input data file, click Browse.
Result:  The Open window opens.
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3. Navigate to the input data file on your network or PC, select it, and Select the file, and click Open.  In the example shown, a file named 2008Death_file.txt is being converted.
Result:  You are returned to the Main Convert window, with the contents of the input data file displayed. 
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At this point, the data displayed does not make mush sense, as a mapping configuration, which includes the input data file layout, has not yet been selected.

4. Select the mapping configuration that was generated for the input data file from the Mapping Configuration drop-down list.
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Result: As soon as the configuration file is selected, the data are displayed in the lower window, so that you can ensure that you have entered your record layout correctly in the mapping configuration, and verify that the correct data items are appearing in their expected locations.
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5. Click Convert to run the mapping process on the input data file and generate the NAACCR-formatted output file.

Result: The Save As dialog window opens.
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6. Enter a name for the NAACCR-formatted output file, and click Save.  In the example shown, the NAACCR output file is named 2008Death_NAACCR.txt.

Result: A window opens and confirms the number of records in the input file.
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7. Click OK to begin the file conversion process.

Result:  The file mapping process begins.  Progress is denoted by the progress bar.
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Data File Mapper Plus lets you know when the conversion is complete, and reminds you of the output file name and path.
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8. Click OK to finish the file conversion process.
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